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About this Guide

Audience and Purpose

This guide is for Microsoft Dynamics CRM administrators who plan to install the D&B360 software
application in their CRM environment.

We assume that you are familiar with how to use a command-line interface and how to download and copy
executable files to your local directory.

If you are interested in more training and education about using our products, learning opportunities are
available here: D&B Training and Education Opportunities for Admin Users.

Conventions

Note: Notes mean reader take note and provide helpful suggestions.

(!) Important Note: Important Notes mean reader be careful. In this situation, you might do something
that could result in loss of data.

In sections that include instructions for using the D&B360 and CRM graphical user interface (GUI):

l Text in bold indicates the name of a window, tab, field, area, or button that you click or interact with.

l Text in monospace indicates a directory path or a command that you need to type in the command-
line interface.

Navigating in the PDF

Note: To download the free, latest version of Adobe Reader, go to this web site:
http://get.adobe.com/reader/.

1. To return to the page you were on after you click a cross reference link, press Alt + Left Arrow.

2. To return to the first page of the document, press the Shift + Home.

3. To navigate in the PDF file or change the Adobe Reader settings, on the Adobe Reader menu,

select View > Page Navigation, Page Display, and Zoom.

http://www.clicktools.com/survey?iv=3a124b4a09708f4&q9=D%26B360%20Salesforce%20Admin|D%26B360%20SAP%20Admin|D%26B360%20Microsoft%20Admin|D%26B360%20Siebel%20Admin|D%26B360%20Oracle%20Admin
http://get.adobe.com/reader/


Related Documentation

For more information about D&B360 from the user perspective, refer to the D&B360 User Guide. For more
information about using the Microsoft Dynamics CRM, refer to the CRM documentation.

D&B360 Administration and Installation Guide About this Guide
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1 Introduction
Welcome to the D&B360 Administration and Installation Guide, which instantly connects you to customer and
prospective customer data that only D&B can provide – plus relevant rest-of-world content, all within your
instance of Microsoft Dynamics CRM. 

Product Benefits 1-1

Guide Objectives 1-2

Guide Organization 1-2

Access to Features 1-2

Product Benefits

With D&B360, you get the business insight you need, the D&B data quality you want, and the ease-of-use you
deserve.

Now you can see all angles of your prospects and customers within your
CRM:

• Know your customers better.

• Acquire new prospects.

• Sell deeper into organizations.

• Improve salesperson effectiveness.

D&B empowers you with relevant and credible information, facilitating your role as a trusted advisor to
enable new sales.



SEE NEW OPPORTUNITIES
Seeing your customers and prospects in a new way can uncover new
information and new-sale entry points.

ACCELERATE YOUR SALES CYCLE
Once you establish relevance and credibility, customers will trust you with their
business.

EXPAND YOUR CUSTOMER

FOOTPRINT

Build customer relationships on a foundation that is based on relevance,
credibility, and trust.

POSITION YOUR SUCCESS

With D&B360, you have a powerful tool that helps you to better
understand your customers pain points, respond to their needs, and
ultimately positions you to win more business.

The D&B360 platform features On-demand access to D&B data,
automatic refresh and synchronization with the D&B database, and
seamless integration of rest-of-world data.

Guide Objectives

The D&B360 Administration and Installation Guidefor Microsoft Dynamics CRM provides instructions for
general D&B360 Administrator tasks.

Guide Organization

The D&B360 Administration and Installation Guide is organized by tasks groups, which are presented in the
sequence in which they occur. For instance, you need to consider the pre-installation requirements before you
can install or upgrade the product. Likewise, you need to install the product before you can configure profiles
or deploy the application.

Access to Features

D&B360 is a powerful tool. You might find more than one way to do a specific task and learn that you can
use a feature or function in more than one area.

For that reason, this guide is organized by functions or tasks you are trying to accomplish. References to links
or menu options that help you navigate your CRM are also included.

D&B360 Administration and Installation Guide 1   Introduction
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2 Getting Started

About D&B360 2-1

Considerations for Administrators 2-2

Pre-Requisite 2-2

Specifying the Requirements for Your CRM Environment 2-4

Hardware Requirements 2-4

Other Requirements 2-5

D&B360 Packages 2-7

Using Rest of World 2-8

Rest of World Applications 2-8

Setting Alerts 2-10

Note: For more information about the user interface and other features of theMicrosoft Dynamics CRM,
refer the user, getting started, installation, and administrator guides for that CRM.

About D&B360

To find basic information and useful links for interacting with D&B360, click About D&B360, located on the
D&B360 menu. You will also find a link to the D&B training web sites here.



Considerations for Administrators

You will be working within the Microsoft Dynamics CRM 2011 (On Demand or On Premise). Take time to
familiarize yourself with the operations of your Microsoft Dynamics CRM environment and the location of the
documentation. This information will help you successfully complete your tasks as a D&B360 Administrator.

If you are an existing D&B 360 user with Batch enabled, you need to complete the following steps:

1. Un-install the Informatica Cloud Secure Agent.

2. Contact Informatica Support (support@informatica.com) to request deletion of the existing Org ID. All

users that belong to this Org ID will also be deleted.

Note: During auto-registration, the Org ID will most likely be different from your previous Org
ID. Org IDs are generated automatically for all registrations.

3. On the D&B360 window, navigate to the D&B360 Administration page and click Batch Setup to

register the new Org ID with Informatica.

4. After this is completed, click Download Secure Agent and install the Secure Agent.

Pre-Requisite

To prepare for the eventuality that a user might want to install or upgrade D&B360, as the admin, you need
to add that users (or users) as a deployment administrator.

l In the Select User window, type the appropriate information to add the user as a deployment
administrator, and then click OK.

D&B360 Administration and Installation Guide 2   Getting Started
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Specifying the Requirements for Your CRM Environment

Before you install D&B360 in your CRM environment, verify that the environment meets the requirements
described in the following sections.

Hardware Requirements

Microsoft Dynamics CRM Server 2011

The following table lists the minimum and recommended hardware requirements for Microsoft Dynamics
CRM Server 2011 running in a Full Server configuration. These requirements assume that additional
components such as Microsoft SQL Server, Microsoft SQL Server Reporting Services, SharePoint, or Microsoft
Exchange Server are not installed or running on the system.

Component Minimum Recommended

Processor x64 architecture or compatible dual core
1.5 GHz processor

Quad-core x64 architecture 2 GHz CPU or
higher such as AMD Opteron or Intel
Xeon systems

Memory 2 GB of RAM 8 GB or more of RAM

Hard Disk 10 GB of available hard disk space

Note: Computers with more than 16
GB of RAM require more disk space
for paging, hibernation, and dump
files.

40 GB or more of available hard disk
space

Note: Computers with more than 16
GB of RAM require more disk space
for paging, hibernation, and dump
files.

Note: Actual requirements and product functionality might vary based on your system configuration and
operating system. Running Microsoft Dynamics CRM on a computer that has less than the recommended
requirements might result in inadequate performance. The minimum and recommended requirements are
based on 320-user load simulation tests.

For more information see: http://technet.microsoft.com/en-us/library/hh699840.aspx

D&B360 Administration and Installation Guide 2   Getting Started
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Microsoft SQL Server for Microsoft Dynamics Server 2011

Microsoft SQL Server database engine and Microsoft SQL Server Reporting Services are required to install and
run on premises versions of Microsoft Dynamics CRM 2011. The following table lists the minimum and
recommended hardware requirements for Microsoft SQL Server. These requirements assume that additional
components such as Microsoft Dynamics CRM Server 2011, Microsoft SQL Server Reporting Services,
SharePoint, or Microsoft Exchange Server are not installed or running on the system.

Component Minimum Recommended

Processor x64 architecture or compatible dual-
core 1.5 GHz processor

Quad-core x64 architecture 2 GHz CPU or
higher such as AMD Opteron or Intel Xeon
systems

Memory 4 GB of RAM 16 GB or more of RAM

Hard Disk SAS RAID 5 or RAID 10 hard disk
array

SAS RAID 5 or RAID 10 hard disk array

Note: Actual requirements and product functionality might vary based on your system configuration and
operating system. Maintaining Microsoft Dynamics CRM databases on a computer that has less than the
recommended requirements may result in inadequate performance. The minimum and recommended
requirements are based on 320-user load simulation tests.

For more information, see: http://technet.microsoft.com/en-us/library/hh699808.aspx

Other Requirements

Client Operating Systems Windows 7, Windows Server 2008 R2, Windows Server 2008 Service Pack 2,
Windows Vista Service Pack 2

Browser Internet Explorer 7, 8

Other Applications Microsoft Silverlight 5

Server Operating Systems l On Premise Only: Microsoft Windows Server 2008 Standard x64 SP2
or later

l Microsoft Windows Server 2008 R2

Databases l On Premise Only: Microsoft SQL Server 2008 Standard x64 SP1 or
later

l Microsoft SQL Server 2008 R2

D&B360 Administration and Installation Guide 2   Getting Started
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MS Dynamics Configuration The Microsoft Dynamics CRM Deployment Manager allows administrators
to set the web addresses for the:

l Web Application Server
l Organization Web Service
l Discovery Web Service
l Deployment Web Service

For D&B360, these services need to be set to the same URL:

l All machines and users that will access the MSD CRM should be able
to resolve this URL.

l As a best practice, D&B recommends that all of the URLs in the
deployment manager be the same as the URL that users will use to
access the CRM.

On Premise Only:
IP addresses to be open on the
firewall

206.80.52.0 to 206.80.53.255

209.34.91.0 to 209.34.91.255

209.62.157.0 to 209.62.157.255

Server Operating Systems Microsoft Windows server 2008 (Standard, Enterprise, Datacenter) x64 SP2
or later; Microsoft Windows Web Server 2008 x64 SP2 or later; Microsoft
Windows Small Business Server 2008 (Standard, Premium) x64 or later*

The following applications must reside on the machine where you install D&B360 for Microsoft Dynamics
CRM:

l .Net Framework 4.0 – http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=17851
l Windows Identity Foundation –

http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=17331
l Select the appropriate version for your machine:

l x86 = 32-bit, x64 = 64-bit
l Windows6.0 = Vista/Server 2008, Windows6.1 = Windows 7/Server 2008 R2

Actual requirements and product functionality may vary based on your system configuration and operating
system.

D&B360 Administration and Installation Guide 2   Getting Started
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D&B360 Packages

The D&B360 features are available in these packages.

Note: Tier 1 packages are available only for on-demand CRM applications. Tier 2 packages are available
for on-premise CRM configurations.

Tier Level Features Supported

Tier 1 applies only to the
Microsoft Dynamics On-
Demand CRM and is
available for 5 to 100
seats.

l Company and Contact Data

l Company Search

l Company Record Creation

l Contact Search

l Contact Record Creation

l Build A List

l Prospecting/List Building

l Rest of World Data

l Segmentation Data

Tier 2 is available for 250
per-seat Premium Contact
credits per year (per user
license) and unlimited
Standard Contacts.

l Company Search

l Company Record Creation

l Record Refresh (Transactional)

l D&B360 and D&B360 Plus Company Append

l Corporate Linkage

l Contact Search

l Contact Record Creation

l Build-A-List

l Company Look-A-Likes

l Industry Information

l Competitors Information

l Advanced Financial Information

l Contextual Social Media

l News

Note: Batch Match Records per Seat, Batch Refresh Records, and 250 contacts per seat are included in
Tier 2. Additional contacts are available as an add-on package. Contact your Sales Representative to
include this in your package.

D&B360 Administration and Installation Guide 2   Getting Started
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Note: De-duplication Check, De-duplication Fix, De-duplication Prevention, and Duplicate DUNS reports
are included. However, these features perform optimally only if you use Batch Match or the DUNS Import
Tool to append DUNS numbers.

Using Rest of World

Rest of World, or ROW, refers to social media applications and news feeds about the companies you are
interested in. These applications interact with your CRM and D&B360 to provide useful information related to
D&B360 data. D&B360 ROW applications display as follows:

When you set user permissions, you will specify which ROW applications users can access. see "Entering D&B
System Settings" on page 4-9. By linking to ROW applications in D&B360, users can get a fully aggregated
information view of their customers from several social and news media sources — all within the CRM
application.

Rest of World Applications

D&B360 currently supports the social and news media applications listed in the following table. From a
D&B360 Account page, click D&B360 ROW to display the ROW tabs. To navigate through the ROW
applications, click the tabs.

ROW Icons Description

Allows you to save items of interest to you and stores them in this tab.

To add an item as a favorite, such as a news story, click the Star icon.
When you see your cursor pointer change into a little hand, click Mark as a
Favorite.

Allows you to track news so you can create customized alerts targeted to your
specific areas of interest. These e-mail alerts include relevant news articles, press
releases, company Web site updates, and blog posts, and are delivered overnight
to your email in-box. Use alerts to stay up-to-date about the most recent
company news, reach out to prospects or customers, create sales opportunities,
and follow events of both public and private companies. For more information,
see "Setting Alerts" on page 2-10

D&B360 Administration and Installation Guide 2   Getting Started
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ROW Icons Description

Displays aggregated headlines from many of the world's news sources. In
D&B360, the News tab displays overall news about the account name with links
to related articles. To open an article, click its link.

Displays stock feeds and financial news feeds about a company from a variety
of sources.

The Map icon pre-populates the Account Billing address and connects to
Microsoft Bing Maps to show the address location.

YouTube is a video-sharing website where users can upload, share, and view
videos. A list of YouTube videos displays from companies in your D&B360
accounts. Only company-authorized videos display.

Blogs display a list of authorized blogs from companies in your D&B360
accounts.

Facebook is a social utility that facilitates communication. Only company
authorized Facebook pages display for each company. To view Facebook
information about people and companies from within D&B360, you need to
have a Facebook account.

A Facebook window opens to the account page you are currently viewing if it
exists in the database. To view the company Facebook information, if you are
not already logged in to Facebook, log in to your Facebook account.

Twitter operates a free digital service site that blends social networking with the
ability to post short messages (or micro-blogs) limited to 140 characters or less,
commonly known by users as Tweets. The Twitter service is designed for use on
personal computers and through mobile devices such as smart phones. Tweets
are published on a poster's personal web page, and can be restricted to select
viewers, or viewed by anyone.

In D&B360, when you click the Twitter tab, a list of that company's official
tweets displays.

D&B360 Administration and Installation Guide 2   Getting Started
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ROW Icons Description

LinkedIn is a business-oriented social networking site where you can connect
with trusted contacts and exchange knowledge, ideas, and opportunities.

If you are not already logged in to LinkedIn, you will need to log in when it
opens in a browser window. If the account you are viewing is in the database, a
LinkedIn window for that company opens. If that company is not found, a
LinkedIn search window opens with that company name pre-populated. Or you
can use the LinkedIn search window to define your search.

Click to make voice calls over the Internet. If you have Skype installed in on your
computer, you can use the Skype icon listed next to phone number to make a
Skype call. If phone numbers for companies, contacts, or leads are in your
D&B360 account information, you can make Skype calls to them.

Setting Alerts

1. When you click the Alerts tab for the first time, in the eMail Address field that displays, type the email

address where you want your alerts digest email to be sent.

2. Click Subscribe.

3. Click Alerts.

4. Select which type of alerts you are interested in, or click Select All.

5. Click Monitor.
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3 Installing D&B360
The following instructions guide you through the installation, set-up, and configuration of D&B360 in your
company's instance of Microsoft Dynamics CRM.

Downloading and Initiating the D&B360 Installation 3-2

Initial Steps: for Installing D&B360 for the First Time, for Upgrading D&B360, and for Re-installing D&B360 3-3

Installing D&B360: Steps that Differ Between First Time Installation, Upgrades, and Re-Installations 3-6

Steps Unique to a First Time D&B360 Installation 3-7

Post Installation: Re-installing or Upgrading D&B360 3-11

Configuring Outlook to Integrate with the MSD CRM 3-17



Downloading and Initiating the D&B360 Installation

You should have already received an email message that contains your installation key, user ID, and
password. After you access the D&B360 registration site and complete your registration, you will receive the
remainder of the installation package.

1. Download the D&B360 executable and configuration installer files and save them to your computer.

2. In the Open File - Security Warning window, click Run.

D&B360 Administration and Installation Guide 3   Installing D&B360
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Initial Steps: for Installing D&B360 for the First Time, for
Upgrading D&B360, and for Re-installing D&B360

These initial steps are the same whether you are installing D&B360 for the first time, upgrading your
software, or re-installing your software:

1. In the D&B360 window, click Next.

2. In the About D&B360 window, click Next.

3. In the Authenticate window, enter the following information, then click Next.

D&B360 Administration and Installation Guide 3   Installing D&B360
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These fields are described in the following table:

Field Action

Select
Country/Region

Use the menu to select your default country/region for support links. Choose from: United
States/Canada, Germany, United Kingdom.

Connect via Use the menu to select Microsoft CRM 2011, Microsoft CRM Online, or Microsoft CRM
Office 365 as your application.

D&B360 Administration and Installation Guide 3   Installing D&B360
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Field Action

Connect as Select Microsoft CRM 2011, Microsoft CRM Online, or Microsoft CRM Office 365.

l If your CRM is hosted locally (also known as on premise), select Microsoft
Dynamics CRM 2011.

l If you have an online account to sign in with that you uses @live as part of the
user name, select Microsoft Dynamics CRM Online (also known as on demand).

l If you have an online account that uses an Office 365 username, select Microsoft
Dynamics CRM Office 365.

l Click Next.

Server URL  Enter the URL of the server where the CRM is installed or the URL that you will use to
access CRM Online.

l For CRM On Demand, the URL will be something like
https://somecompany.crm.dynamics.com

l For CRM On Premise, the URL will be something like https://servername

D&B360 Administration and Installation Guide 3   Installing D&B360
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Field Action

Organization Type the name of the CRM organization that you want to install to.

l For normal CRM 2011 deployments, you can get the org name from the URL such
as: http://someserver/someorg

l For IFD deployments, you can get org name from the URL such as:
http://someorg.someserver

l For CRM Online, you can get the URL such as:
https://somecompany.crm.dynamics.com

Installing D&B360: Steps that Differ Between First Time
Installation, Upgrades, and Re-Installations

The steps will differ somewhat depending on whether you are installing D&B360 for the first time, upgrading
your software, or re-installing your software.
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Steps Unique to a First Time D&B360 Installation

1. In the Trial Terms window, click Begin.

Note: Trial customers—Your 60-day trial period begins at the point of installation, as noted in
the trial terms. If you are not yet ready to configure D&B360,we recommend that you click
Cancel and configure your software when you are ready to start using it. This will allow you to
take full advantage of your trial period.
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2. In the Trial Terms and Conditions window, read the terms, and then click Accept.

3. In the D&B Key window, type the installation key that D&B emailed to you.

Note: To facilitate flexibility in testing or deploying in various environments, we allow you to
use this Installation Key in up to 3 environments. Each Installation Key has a specific set of limits
defined by either your trial terms or your contract.
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4. In the Provided By field, click D&B or Microsoft to specify who provided the link to the installation

software.

5. Click Register Key.

6. If you did not choose to delete default data,in the Options window, select Install D&B Managed

Solutions.

— or —

If you deleted default data, in the Options window, select Install Default Data.
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7. Click Next.

Completing Your First Time Installation

To complete a first-time installation:

1. In the Final Review window, click Install.

D&B360 Administration and Installation Guide 3   Installing D&B360
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Note: Depending on your network connection, the application will take about 5 to 7 minutes to
install.

2. In the final installation window, click Finish.

For help with errors after you have installed D&B360, see "Resolving Installation Issues" on page 8-11.

Post Installation: Re-installing or Upgrading D&B360

(!) Important Note: If for some reason you need to delete your default data, you must do that first before
you re-install or upgrade the software. For more information, see "Processing Batches — Standard Level
Expectation" on page 8-10.

If you deleted default data, you can reinstall the default data by selecting the Install Default Data check box.
For more information, see this step on page 3-9.
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Re-Installing D&B360 Upgrading D&B360

Note: You typically only need to re-install
D&B360 when updating the Look-Up table.

If you are reinstalling the software, the Modify
Installation window with Reinstall D&B360
selected opens.

Note: You usually install an upgrade when a new
software release is available. This might include
new features or bug fixes.

If you are upgrading D&B360, the Modify Installation
window with Upgrade D&B360 selected opens.

1. In the Modify Installation window, make

sure Reinstall D&B360 is selected.

2. Click Accept.

1. In the Modify Installation window, make sure

Upgrade D&B360 is selected.

2. Click Accept.

3. In the Trial Terms window, click Begin.

D&B360 Administration and Installation Guide 3   Installing D&B360

©Dun & Bradstreet, Inc. 2013 3-12



You should have the installation key in the email message that D&B sent to you. After you complete the
registration process, access the D&B360 registration site to download the remainder of the installation
package.

Note: To facilitate flexibility in testing or deploying in various environments, we allow you to use this
Installation Key in up to 3 environments . Each Installation Key has a specific set of limits defined by either
your trial terms or your contract.

1. In the Terms & Conditions window, click Accept.

Note: The Installation Key is pre-populated.

2. In the Provided By field, click D&B or Microsoft to specify who provided the link to the installation

software.

3. In the D&B Key window, click Register Key.
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Note: The Installation Key is pre-populated.

4. After the software successfully registers, in the D&B Key window, click Next.

5. If you did not choose to delete default data, make sure Install D&B Managed Solution is selected.

— or —

If you did choose to delete default data, make sure Install Default Data is selected.

D&B360 Administration and Installation Guide 3   Installing D&B360

©Dun & Bradstreet, Inc. 2013 3-14



6. In the Options window, click Next.

Note: If you deleted your data, you must click Install Default Data instead of using the default
setting, Install D&B Managed Solution.

7. In the Solution Settings window, leave the default Maintain Unmanaged Customizations, or click to

select Overwrite Unmanaged Customizations, then click Next.
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8. To complete the installation, in the Final Review window, click Install.

Depending on your network connection, the application might take anywhere from 5 to 7 minutes to

install.

9. After the re-installation or upgrade has successfully completed, click Finish.

10. If your CRM is open in a browser window, refresh or reload your page to see the changes.
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Configuring Outlook to Integrate with the MSD CRM

The Microsoft Dynamics CRM2011 configuration wizard should already be installed. See Start -> Programs ->
Microsoft Dynamics CRM 2011. If it is not, download and install it from this web site:
http://www.microsoft.com/en-us/download/details.aspx?id=27821

1. Close Outlook.

2. From your Start menu, select Programs -> Microsoft Dynamics CRM 2011 -> Configuration Wizard.

In the Microsoft Dynamics CRM 2011 for Outlook Configuration Wizard window, the default URL and

organization display.

3. Click Add.
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4. In the Microsoft Dynamics CRM 2011 for Outlook Configuration Wizard window:

a. In the Server Information area, verify that the Server URL is correct, and click Test Connection.

b. Verify that the connection was successful.

c. In the Organization Information area, type your Organization name and Display Name.

d. Click OK.
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4 Configuring D&B360

Providing D&B Access to Microsoft Dynamics CRM Users 4-1

Ensuring the D&B360 Application is Available 4-2

Viewing Available D&B360 Roles 4-3

D&B360 Administrator Permissions 4-5

D&B360 User Permissions 4-7

Assigning Roles to Users 4-9

Entering D&B System Settings 4-9

Configuring the D&B System Settings 4-9

Configuring the D&B Button Settings 4-11

Configuring Rest of World (ROW) Settings 4-12

Configuring D&B Stare and Compare Settings 4-12

Providing D&B Access to Microsoft Dynamics CRM Users

By default, all Microsoft Dynamics CRM administrators have access to D&B360. Two security roles are always
included in the D&B360 application:

D&B360
Administrator

Features and Administration Page: This role has full access to all D&B360 features
including access to the D&B360 Administration page.

D&B360 User Features Only: This role has full access to all D&B360 features excluding access to the
D&B360 Administration page.

For existing users who need access to the D&B360 application to complete any required configurations, as the
Microsoft Dynamics CRM administrator, you need to add the D&B360 Administrator security role to their
current security role assignments.

For existing users who have responsibilities within D&B360, you need to assign the D&B User role.



Ensuring the D&B360 Application is Available

1. From the left menu, below Settings, select Settings -> Customization -> Solutions.

2. To verify that the application is installed, verify that it displays in the Solutions area.

You can verify the version number and installation date in this window.
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3. To view the application components, on the Solutions window, double-click D&B360.

The Information window opens and displays the components.

Viewing Available D&B360 Roles

1. From the left menu, select System -> Administration.

2. To display the security roles available to you, click Security Roles.

The Security Roles window opens and displays the roles available to you.
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You can select from these 8 possible tasks that are permitted for a variety of components:

Create Read Write Delete

Append Append To Assign Share

To view which tasks are permitted for the components of each role:

1. In the Security Roles window, select the name of the role you want to review.

D&B360 Administration and Installation Guide 4   Configuring D&B360

©Dun & Bradstreet, Inc. 2013 4-4



2. In the Security Role D&B Administrator window, click Customization to display permissions

associated with this role.

3. To view remaining permissions, click Custom Entries.

D&B360 Administrator Permissions

In the Security Role: D&B Administrator window, Customization tab, administrator permissions are
indicated by green (user type) circles.
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In the Security Role: D&B Administrator window, Custom Entries tab, administrator permissions are also
indicated by green (user type) circles.
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D&B360 User Permissions

In the Security Role: D&B User window, Customization tab, administrator permissions are indicated by
green (user type) circles.
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In the Security Role: D&B User window, Custom Entries tab, administrator permissions are also indicated by
green (user type) circles.
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Assigning Roles to Users

Follow your standard process for applying security roles to users. You can assign these roles to users: D&B360
Administrator and D&B360 User.

Note: Only someone who is assigned the role of administrator is authorized to configure settings. After
you have been assigned the role of D&B360 Administrator, you can configure the D&B360 settings.

Entering D&B System Settings

After you have verified that the D&B360 application is ready to use and that you are assigned the
Administrator role, you are ready to set the required configurations.

Configuring the D&B System Settings

1. From the left menu below Settings, select D&B360 -> D&B360 Administration.
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2. In the D&B360 Administration window, scroll to System Settings -> D&B System.

Collapse the Welcome to D&B360 and D&B Licensing sections to have more space on the window.

3. Expand System Settings, and in the D&B System area, use the menus to configure these settings:

a. Select the Default Country that you want to use when you search for accounts.

b. In the Country and State fields, select either Description or ISO Code to determine how the system

returns searches by country. You can change this setting later, but it will only affect new or refreshed

records.

c. In the Callout Timeout field, select either 30 seconds or 60 seconds to specify the amount of time

the system waits for a response from web services.

4. For the Allow fields, generally keep the default settings.

5. Click Save.
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Configuring the D&B Button Settings

1. In the System Settings, D&B Button Configuration area, click the Yes or No radio buttons to select

which buttons you want to display on the CRM window D&B 360 menu. See the button descriptions

below.

2. Click Save.

D&B360 Options Description

D&B Data Allows you to change or remove D&B data (including company, contact, and lead
data) about an existing account, or to add D&B data to an account in your database
that does not yet include D&B data.

D&B Refresh Imports the most current D&B data for a specific account and performs a stare and
compare for the data in the Account object compared to the D&B360 object.

D&B360+ Displays all of the D&B data licensed by the company for a specific account. Data is
only for the company and does not include contact or lead information.

D&B360 Contacts Searches for contacts associated with a D-U-N-S Number or Company Name and
create leads or contacts from them.

D&B360 View Identifies related accounts within your Account object. You can also bring in family
members for cross-sell opportunities.

D&B Look A Like Searches for other companies that have similar attributes to their best customers.

D&B Competitors Accesses a list of competitors, assembled by D&B’s editorial team, that are associated
with a D-U-N-S Number or Company. You can use this list for creating accounts,
contacts, or leads.

D&B Industry Searches for industry profiles associated with a D-U-N-S Number or Company to
quickly gain powerful insight that accelerates the sales cycle. Industry profiles are
powered by First Research industry experts

D&B Financial Searches for additional financial data specific to your D&B360 accounts such as
annual income statements, growth rates, per share data, and more associated with a
D-U-N-S Number or Company.
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Configuring Rest of World (ROW) Settings

1. In the System Settings, ROW Annotation Configuration area, click to select the check boxes for each

of the Rest-of-World options that you want to make available to your users.

2. Click Save.

Note: If you clear a check box, none of your users will be able to use that ROW option within the
D&B360 application.

For more information about the ROW options, see "Using Rest of World" on page 2-8.

Configuring D&B Stare and Compare Settings

1. In the System Settings, D&B360 Stare and Compare area, click to select the check boxes for each of

the stare-and-compare options that you want to make available to your users.

2. To allow your users to update the CRM DATA values for the fields in the Select Fields for update in

Stare and Compare section, click Preselect Differences.

3. Click Save.
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5 Managing Batches and Installing the Informatica
Cloud Secure Agent

Overview of Batch Processing 5-4

Understanding the Key Features of D&B360 Batch Jobs 5-4

Record Eligibility 5-4

Confidence Code Threshold Facts 5-4

Validating D-U-N-S Numbers 5-5

Configuring Microsoft Dynamics 5-5

Registering the Secure Agent for an On-Demand Installation 5-6

Configuring the Secure Agent for an On-Premise Installation 5-8

Installing the VC++ Redistributable Package (x86) 5-8

Steps for Configuring the Secure Agent for an On-Premise Installation 5-11

Logging in to the Informatica Cloud Secure Agent 5-12

Running the Informatica Cloud Secure Agent Installation Program 5-14

Preparing Your Microsoft Dynamics and Active Directory for the Informatica Cloud Secure Agent 5-19

Post-Installation Steps 5-26

Adjusting the Settings for Your System 5-28

Completing the Optional Steps 5-30

Restarting the Secure Agent 5-31

Note: If you are installing Microsoft Dynamics CRM for On Premise, also known as CRM Active Directory,
see "Registering the Secure Agent for an On-Demand Installation" on page 5-6.



Note: If you are installing Microsoft Dynamics CRM for On Demand, also known as CRM Live, see
"Configuring the Secure Agent for an On-Premise Installation" on page 5-8.

For an overview of the steps needed for each type of installation, see the following flowchart.
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Overview of Batch Processing

Two batch jobs are available through D&B360:

l New Batch — Use to associate existing Microsoft Dynamics accounts with a valid D-U-N-S record. New
Batch chooses accounts from Microsoft Dynamics and sends the account name and address to D&B for
potential cleanse, match, and append processes. After D&B returns the batch records, the accounts in
Microsoft Dynamics are associated with a valid D-U-N-S number.

l Refresh Batch — After Microsoft Dynamics accounts are associated with a D-U-N-S number, a Refresh
Batch is used once a month, or once a week, to refresh the D-U-N-S data stored in D&B360 Microsoft
Dynamics tables.

Understanding the Key Features of D&B360 Batch Jobs

The three key features of D&B360 Batch jobs are:

l Record Eligibility

l Confidence Code Threshold Facts

l Validating D-U-N-S Numbers

Record Eligibility

Every record picked for New Batch processing goes through a data quality check procedure. To pass this quality
check, a record must have a Company Name and one of the following:

This field: Phone

2 of these fields: Billing City, Billing State, Billing Postal Code

5 of these fields: Billing Address, Billing City, Billing State, Billing Postal Code, Billing Country,
Phone

Note: If none of the three criteria is met, the records will get pushed to the Admin Review List.

Confidence Code Threshold Facts

l The range of Confidence Code is: 1 to 10

l Any number above 8 is considered to result in accurate match records.

l The setting can be adjusted by a D&B360 Administrator in the Batch Setup screen.
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Records from D&B that fail to meet the defined Confidence Code Threshold are moved to the Admin Review
List. They are not automatically re-processed in the next batch run. As the Administrator, you must manually
process these records.

Validating D-U-N-S Numbers

An event such as a merger or acquisition can result in changes to the D-U-N-S number for a record.

Note: A Recertified D-U-N-S has occurred when we send records to D&B in a Refresh Batch job, and the
returned records have a new D-U-N-S Number.

In the case of a Merger or Acquisition, re-certified D-U-N-S records will be updated within the D&B360 table
with the following:

l Re-cert reason code

l Re-cert description

l DATS date when the new DUNS Number was assigned

Configuring Microsoft Dynamics

The configurations available for Microsoft Dynamic CRM, and their specific required modifications, include
the following.

Note: Microsoft Dynamics CRM On Demand is also known as CRM Online or CRM Live. Microsoft
Dynamics On Premise is also known as CRM Active Directory.
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Microsoft Dynamics CRM On
Demand

Requires:

l Configuration of Batch Job Connection.

l Registration of Informatica Cloud Secure Agent (see
"Registering the Secure Agent for an On-Demand Installation"
on page 5-6).

Microsoft Dynamic CRM On
Premise

Requires:

l Installation of Informatica Cloud Secure Agent (see
"Configuring the Secure Agent for an On-Premise
Installation" on page 5-8).

l Installation of Batch Job Initialization Files.

l Configuration of Secure Agent.

l Configuration of Batch Job Connection.

(!) Important Note: Make note of these requirements:

l To identify the type of configuration for your CRM, contact your System Administrator. For instructions
on how to configure your CRM, see "Configuring the Secure Agent for an On-Premise Installation" on
page 5-8.

l To install the Informatica Secure Agent, the user must be an admin user for the CRM, a system
administrator for the server where the secure agent is to be installed, and an administrator for the
Domain Name Server (DNS) in the network.

l To install the Informatica Secure Agent, the user must be an admin user.

l Before you can set up and run batches, you must install the Informatica Secure Agent for Microsoft
Dynamics. For instructions on installing the Secure Agent, see "Registering the Secure Agent for an On-
Demand Installation" on page 5-6, or see "Configuring the Secure Agent for an On-Premise Installation"
on page 5-8.

Registering the Secure Agent for an On-Demand Installation

Note: On Demand is also known as online or CRM Live.
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1. On the CRM left menu, click Settings to display the D&B360 choices.

2. Select D&B360 -> D&B 360 Administration.

3. In the Batch Processing Setup area, click Batch Setup.

In the D&B360 Batch Administration window, the system generates your Username and Password.

(!) Important Note: Make a note of the Username and Password the system generates for you. You will
need to have these for steps that follow.

4. In the Deployment Type field, select Online, and then click Register.
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5. In the CRM Connection Credentials area, type the user name and password you were given in the

previous step, then click Save.

After you have completed these steps, you are ready to schedule new and refresh batch jobs (see "Scheduling
Batch Jobs" on page 6-1).

Configuring the Secure Agent for an On-Premise Installation

Before you configure the secure agent for an on-premise installation, you need to install the
VC++ Redistributable Package (x86).

Installing the VC++ Redistributable Package (x86)

1. Open http://www.microsoft.com/download/en/confirmation.aspx?id=29.

2. Click Start download.

D&B360 Administration and Installation Guide 5   Managing Batches and Installing the Informatica Cloud Secure Agent

©Dun & Bradstreet, Inc. 2013 5-8

http://www.microsoft.com/download/en/confirmation.aspx?id=29


3. When you are prompted to run or save the .exe file, click Run.

The Welcome to Microsoft Visual C++ 2008 Redistributable Setup wizard opens.
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4. In the first wizard window, click Next.

5. In the License Terms window, I have read and accept the license terms field, select the check box.

6. Click Install.
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As the installation is in progress, the Setup window displays the status.

7. In the Setup Complete window, click Finish after the installation is complete

Steps for Configuring the Secure Agent for an On-Premise Installation

If you have multiple Microsoft Dynamics organizations on a site, for each organization to have connectivity,
you must install the Secure Agent on a separate machine for each organization.
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1. On the CRM left menu, click Settings to display the D&B360 choices.

2. Select D&B360 -> D&B 360 Administration.

3. In the Batch Processing Setup area, click Batch Setup.

4. In the User Registration and Secure Agent Installation window, type your user name and password.

(!) Important Note: Make a note of this because you will use these later to register the Secure Agent.

5. In the Deployment Type field, select On Premise, and then click Register.

Logging in to the Informatica Cloud Secure Agent

1. Access the Informatica Cloud window at this URL: https://icosp2.informaticacloud.com/saas.

2. In the Informatica Cloud window, type the user name and password for the CRM that you made note

of previously, and then click Login.
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3. In the Informatica Cloud window, click the Configuration tab, then click the Agents tab.

4. Click Download Agent.

5. In the Download Agent dialog box, click Windows, then click Download.
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6. At the prompt to run or save the .exe file, click Run.

Running the Informatica Cloud Secure Agent Installation Program

1. In the Informatica Cloud Secure Agent Setup window, Choose Installation Folder area, leave the

default program directory or click Choose to specify a different location.

2. To install the secure agent, click Next.
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3. In the Pre-Installation Summary window, review the settings and if everything is correct, click Install.

The Installing window displays the progress of the installation process.

4. In the Installation Complete window, review the summary of the installation, and then click Done.
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5. In the Informatica Cloud Secure Agent registration window, type the user name and password that

you made note of when you registered through the CRM, and then click Register.

The Informatica Cloud Secure Agent window displays a message that it is starting up and upgrading.

After the upgrade process is complete, a message displays that the secure agent is up and running.
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6. In the Informatica Cloud window, type the user name and password that you made note of earlier.

The Configuration window displays the log in credentials you entered previously.

7. In the D&B360 User Registration and Secure Agent Installation window, Deployment Type field,

select On Premise, then click Next.

8. Type the user name and password you entered in previous steps.
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If you have correctly registered the CRM, the CRM Connection Credentials window displays.

9. To connect to the CRM, in the D&B Batch Administration window, CRM Connection Credentials area,

type your User and Password information.
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If the Secure Agent fails to successfully associate with the CRM, an error message displays. If you get

this error message, try re-typing your user name and password. If you get the error message again, click

the link in the error message to download and install the Secure Agent.

If you have correctly registered the CRM, the CRM Connection Credentials window displays.

Preparing Your Microsoft Dynamics and Active Directory for the
Informatica Cloud Secure Agent

(!) Important Note: If the CRMAppPool is running as Network Service, watch for and read the Important
Notes that precede some of the following steps. To avoid problems with your installation, it is important
that you skip any steps preceded by an Important Note stating that you skip that step.
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Specify the Identify for CRMAppPool

l Log in to your MSD Application server.

Identify the Port for Your CRM Dynamics Instance

1. On the left side of the MSD CRM window, select Actions -> Edit Site, and click Bindings.

2. In the Site Bindings window, identify the port number that is bound to your Dynamics instances, and

click Close.

D&B360 Administration and Installation Guide 5   Managing Batches and Installing the Informatica Cloud Secure Agent

©Dun & Bradstreet, Inc. 2013 5-20



Identify the Service Principal Name (SPN) for the Environment.

(!) Important Note: If the CRMAppPool is running as Network Service, skip all of the steps in this section:

1. Log in to the Domain Controller.

The Administrator: Windows Powershell window opens.

2. To identify the name of your Domain Controller host, enter the hostname command.

3. To identify the SPN for your environment, enter the setspn -l hostname command. This should be

a fully qualified domain name (FQDN).

The SPN name starts with HOST and contains the FQDN for the machine.

4. Enter the following command with the values obtained in the previous steps as follows:

setspn -A iisadmin/<spn>:<port> <user>

l where <spn> is the result from Step 3

l <user> is the result from Step 1

l <port> the result from Step 2

In our example, this is

setspn –A iisadmin/crm2011local.msdvm.com:5555 MSDVM\CRMDynamics

D&B360 Administration and Installation Guide 5   Managing Batches and Installing the Informatica Cloud Secure Agent

©Dun & Bradstreet, Inc. 2013 5-21



5. Enter the command:

setspn –A HTTP/<spn>:<port> <user>

In our example, this is

setspn –A HTTP/crm2011local.msdvm.com:5555 MSDVM\CRMDynamics setspn –A

HTTP/<spn> <user>

6. Enter the command:

setspn –A HTTP/<spn> <user>

In our example, this is

setspn –A HTTP/crm2011local.sdvm.com MSDVM\CRMDynamics

Setting Delegation

(!) Important Note: If the CRMAppPool is running as Network Service, skip all of the steps in this section.

1. Log in to your Domain Controller and select Active Directory Users and Computers.
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2. In the Active Directory Users and Computers window, select msdvm.com/Users.

3. In the Users directory, locate the User identified in the Step 1 and double-click it (see this step on page

5-21).

4. In the CRMDynamics Properties window, select the Delegation tab.
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5. Select the Trust this user for delegation to specified services only and Use Kerberos only options, and

then click Add.

6. Click Users or Computers.
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7. Enter the user name identified in Step 1 and then click OK ( see this step on page 5-21).

8. Select the HTTP entry whose Port column is blank, and then click OK.
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Post-Installation Steps

1. In the Informatica Cloud Secure Agent Setup window, click Stop.

The Secure Agent shuts down.

A message displays to inform you that the Secure Agent has been stopped.

2. In the Informatica Cloud window, click the Administration tab.
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3. Log back in to Informatica Cloud using the user name and password you previously entered.

4. In the My Organization window, identify the Organization ID for your installation, for example, Org87.

5. In the Secure Agent ..\Informatica Cloud Secure Agent\main\rdtmDir\dnb360\

directory, create a folder with the Organization ID name.

6. Download the Java Security Policy Files from this URL:

http://www.oracle.com/technetwork/java/javase/downloads/jce-6-download-429243.html.

7. Unzip the zip package and copy:

local_policy.jar and US_export_policy.jar
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8. Paste the unzipped files in the

Program Files (x86)\Informatica Cloud Secure Agent\jre\lib\security

directory and overwrite the existing files.

Adjusting the Settings for Your System

1. In the Administrator Windows PowerShell window, identify your domain name.

In our example, the domain name is MSDVM.

2. Use Notepad to edit the krb5.conf file, which is located in the

Program Files (x86)\Informatica Cloud Secure

Agent\main\bin\rdtm\javalib\msdcrm\conf directory, and enter the values for your system.

In our example, the domain is MSDVM.COM, and the machine name where the CRM is located is

crm2011local.
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The following is an example krb5.conf file.

[libdefaults]

default_realm = MSD.SAMPLE.COM

default_tkt_enctypes = rc4-hmac

default_tgs_enctypes = rc4-hmac

permitted_enctypes = rc4-hmac

[realms]

MSD.SAMPLE.COM = {}

kdc = xxx.msd.sample.com

default_domain = MSD.SAMPLE.COM

}

[domain_realm]

.MSD.SAMPLE.COM = MSD.SAMPLE.COM

3. Save the file.

(!) Important Note: If the CRMAppPool is running as Network Service, skip the following step:

4. Use Notepad to edit the login.conf file, which is located in

Program Files (x86)\Informatica Cloud Secure

Agent\main\bin\rdtm\javalib\msdcrm\conf

directory, and enter the values for your system.

CRMDynamics is the user under which the MS Dynamics has been installed.

5. Save the file.
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Completing the Optional Steps

Optional Step for Only When the MSD Application is Accessed using HTTPS

This step is required only if you are using self-signed certificates.

1. Configure the Java Security for Microsoft Dynamics Active Directory (MSD AD) instance.

2. Generate the root and intermediate Secure Socket Layer (SSL) certificates for HTTPS URL (.cer files).

3. Use the command line to install certificates (certs) for JRE.

a. Use CMD and navigate to <agentdir>/jre/bin/

b. Type the command: keytool -importcert -alias <certificate alias name> -

file " <certificate path>\<certificate filename>" -keystore

..\lib\security\cacerts -trustcacerts

Where Certificate Alias Name is any unique name and file is the full path to the .cer files

Example: Root certificate = RootCA1.cer

keytool -importcert -alias MSDROOT -file " <file path>\ RootCA1.cer " -keystore ..\lib\security\cacerts

-trustcacerts

Default JRD password: changeit

Optional Step When the DNS Is Unable to Perform Host Resolution

If the DNS is improperly set, you might need to add the IP address and hostname to your hosts file to resolve
the hosts used for MSD deployment. For example, in Windows 7, the IP address can be found in this directory -
- C:\Windows\System32\drivers\etc.

D&B360 Administration and Installation Guide 5   Managing Batches and Installing the Informatica Cloud Secure Agent

©Dun & Bradstreet, Inc. 2013 5-30



Restarting the Secure Agent

l Open the Informatica Cloud Secure Agent window, and click Restart.

The Informatica Cloud Secure Agent starts up.
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A message displays to inform you that the Secure Agent is up and running.

After you have completed these steps, you are ready to schedule new and refresh batch jobs (see "Scheduling
Batch Jobs" on page 6-1).
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6 Scheduling Batch Jobs

Scheduling New and Refresh Batch Jobs 6-1

Scheduling a New Batch Job 6-1

Scheduling a Refresh Batch Job 6-3

Scheduling New and Refresh Batch Jobs

For batch processing turnaround time, see "Processing Batches — Standard Level Expectation" on page 8-10.

Each batch job has its own distinct schedule:

New Batch When you are ready to execute a batch job for the first time, you must
run the New Batch Job.

Refresh Batch You can run Refresh Batch only after you have run New Batch at least
once.

After the first run of New Batch job completes successfully, you can run both jobs in any order or in parallel.

Note: For both New Batch Jobs and Refresh Batch Jobs, the start date and time is a mandatory field.To
cancel a job that you've scheduled to run at a future date and time, enter a past date and time. If your job
has already started, you cannot cancel it.

Scheduling a New Batch Job

1. In the D&B360 Administration window, click Batch Setup.



2. In the CRM Connection Credentials area, type your User and Password information.

3. In the New Batch Schedule area, enter the Start Time for a new batch:

a. To set the date, type it or use the calendar.

b. To set the time, type it or use the clock.

4. In the Confidence Code field, select from 1 to 10. The default is 8. We recommend using a relatively

high confidence code.

5. Click Save.

6. In the Repeat Frequency area, use the menu to specify how often you want to run the batch job, either

None, Daily, or Monthly (see "Repeat Frequency" on page 6-3).

Note: The Start Time field, which includes the calendar date and time of day, is mandatory.To
cancel a job that you've scheduled to run at a future date and time, enter a past date and time. If
your job has already started, you cannot cancel it.
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In our example, the Repeat Frequency is set to Monthly, and the Repeat Options are set to Repeat

Indefinitely.

Repeat Frequency

None Daily Monthly

Run the
Task

Select Start Time
and Date

Select Every day or Every
weekday

l Select Day of the month, or
l Select the first, second, third, fourth, or

last day of every month

Repeat
Options

N/A l Select Repeat indefinitely or
l Repeat until and choose the date and time.

Scheduling a Refresh Batch Job

Before you can schedule a Refresh Batch Job, which repeats a previous batch job, you must have run a New
Batch job at least once (see "Scheduling a New Batch Job" on page 6-1).

1. In the D&B360 Batch Administration window, click Refresh Batch Schedule.

2. Follow the instructions in the previous section for setting the Start Time, Repeat Frequency, and

Repeat Options.

Note: The Start Time field, which includes the calendar date and time of day, is mandatory.To
cancel a job that you've scheduled to run at a future date and time, enter a past date and time. If
your job has already started, you cannot cancel it.
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For example, if you want to set the Repeat Frequency to Monthly, you can specify which day of the

month and which day of the week to repeat the job as shown in the following illustrations:

3. To save these batch settings, click Save.

D&B360 Administration and Installation Guide 6   Scheduling Batch Jobs

©Dun & Bradstreet, Inc. 2013 6-4



©Dun & Bradstreet, Inc. 2013 7-1

7 Reviewing Logs, Admin Review Lists, and
D&B360 Reports

After you have scheduled batches, you need to monitor the batch processes and be alert for incomplete results.
You also need to review the results from batch jobs.

Accessing the Callout Logs 7-1

Accessing the Administrator Review List 7-3

Using the Admin Review List 7-3

Viewing and Processing Failed Batched Records Listed in the Administrator Review List 7-4

Viewing D&B360 Reports 7-6

Duplicate DUNS Report 7-6

Using the Duplicate DUNS Report to Merge Duplicate Accounts 7-6

Recertified DUNS Report 7-7

Accessing the Callout Logs

Callout logs track all WebService calls made between your CRM system and D&B.

1. In the left menu, select D&B360 -> D&B Callout Logs.  



2. To get additional information about a transaction, click the Transition Id.

Information about this transaction displays in a new window.
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Accessing the Administrator Review List

l In the D&B360 Administration window, select Batch Processing Setup -> Admin Review List. You can
also click Admin Review List in the D&B360 Batch Administration window.

Using the Admin Review List

Two failure types are reported after batch processing:

Failure Type Means that …

Data Quality the Data Quality of the Account Record failed to meet the minimum requirements set for
D&B360 Batch processing.

Below
CC Threshold

the D&B record matched to your input record was below the customer-assigned confidence
code

Note: Records that fall below the defined Confidence Code Threshold are moved to the Admin Review List.
They are not automatically re-processed in the next batch run. You must manually process these records.

1. In the D&B360 Admin Review window, next to each failed record that you need to resolve, click Select.
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2. In the D&B Account Search window, click Select to view the results.

After you find the match for the correct company and add it to the D&B360 object, the failed record is

removed from the Admin Review List.

Viewing and Processing Failed Batched Records Listed in the
Administrator Review List

Accounts without a D-U-N-S Numbers are batched and sent to D&B for matching with D&B’s D-U-N-S data.
Some accounts cannot be sent because they don’t meet 80% completeness. These accounts are listed in the
Admin Review List for review and resolution.

When the information is returned from D&B, most of the accounts will have been matched with D-U-N-S
Numbers. Some accounts will be sent to the Admin Review List for one of the following reasons:

l They were unable to be matched.

l They were matched, but the confidence code is below the default.

Whenever accounts are on the Admin Review List, you must review the information and correct it so that these
accounts can be successfully processed.
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Refresh batch results can also produce items that you must manually review and resolved. For example, you
need to change or accept the modified data.
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Viewing D&B360 Reports

The two D&B360 reports that are valuable in the review and resolution of some common situations include:

l Duplicate DUNS Report

l Recertification Report

Duplicate DUNS Report

If more than one account with the same D-U-N-S Number exists, it is listed on the Duplicate DUNS report.7.

Note: The tier level of your license agreement determines the type of access you have: Tier 1: Access to
report, but cannot merge accounts.

To resolve duplicates, you need to review the information in each of the duplicates and then:

l Decide which one is the master – that is, which one should be the primary selection.

l Select an account with information you want to merge into the master.

Note: If you have three or more accounts with the same D-U-N-S Number, you can merge the
information from more than one account into the master. However, you must do the merge
operations one at a time since the merge function merges information from two sources at a
time.

Using the Duplicate DUNS Report to Merge Duplicate Accounts

You can merge a maximum of two accounts at a time.

1. In the D&B360 Duplicate D-U-N-S window, select the two account records you want to merge.

2. Above the check boxes, click Merge.

3. In the Merge Records window, select the data you want to retain after the merge is complete.
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4. Select which of the accounts will be the Master record. You can select which fields on which records you

want to take precedence.

(!) Important Note: After accounts are merged, all contacts, opportunities, attachments, notes, and so
forth from the subordinate account are moved to the master account record. It is recommended that you
carefully evaluated the fields in the Merge Records window before merging the accounts.

5. To complete the merge process, click OK.

Recertified DUNS Report

Information about a company might change periodically, which triggers a change in the D-U-N-S Number.

Use the recertified DUNS Report to identify these issues so that you understand. If necessary, you can modify
your account information.

This feature is avilable only for Tier 2 licenses.
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8 Troubleshooting

Enabling D&B360 Administration on a Customized SiteMap 8-1

Finding Your SOCID and TPCID 8-10

Processing Batches — Standard Level Expectation 8-10

Resolving Installation Issues 8-11

Resolving Problems 8-12

Enabling D&B360 Administration on a Customized SiteMap

If you customized your site map (SiteMap), but you are not seeing the D&B360 Site Map options, use these
steps to add it.

1. Open the SiteMap Editor window and connect to your CRM.



2. In the SiteMap window, right-click Area (Settings) and select Add Group.

3. In the Properties window:

a. In the Id field, type DnB360.

b. In the Title field, type D&B360.
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4. In the Site Map Editor window, right-click Group (DnB360) and select Add SubArea.

5. In the Properties window:

a. In the Id field, type dnb_administration.

b. In the Entity field, type dnb_settings.

c. In the Url field, enter:

$webresource:dnb_/WebResources/DnB360.Crm.WebResources.Administration.html

d. In the Title field, type D&B360 Administration.

e. Click Save.
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6. In the Site Map Editor window, right-click SubArea (dnb_administration) and select Add Privilege.

7. In the Properties window, Entity field, type dnb_settings, select Create, and then click Save.
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8. In the Site Map Editor window,right-click Group (DnB360), and select Add SubArea.
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9. In the Properties window:

a. In the Id field, type dnb_calloutlog.

b. In the Entity field, type dnb_calloutlog.

c. Click Save.
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10. In the Site Map Editor window, right-click Group (D&B360) and select Add SubArea.
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11. In the Properties window:

a. In the Id field, type dnb_lookup.

b. In the Entity field, type dnb_lookup.

c. Click Save.

12. Click Update SiteMap.

For on-demand (Live) environments, it might take a few minutes for the settings to take effect. You might
want to publish all customizations.
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Finding Your SOCID and TPCID

If you need to contact D&B Customer Support, you might be asked to provide your SOCID and TPCID. These
identification numbers are specific to D&B360 in your Microsoft Dynamics CRM environment. The TPCID may
be better known to you as the globally unique identifier (GUID).

1. In the D&B360 Administration window, click About D&B360.  

2. In the Support Information area, your TPCID and SOCID display.

Processing Batches — Standard Level Expectation

The standard level expectation (SLE), for batch processing turnaround time, is as follows:

Domestic Batches – 12 hour turnaround

l United States and Canada

l Batch sizes of 50,000 or less

l 90% of files

Global Batches – 24 to 48 hour turnaround

l Any batch containing files outside the United States or Canada

l Batch sizes of 50,000 or less

l 90% of files

Note: System maintenance for D&B Systems occurs Saturday 11 P.M. to Sunday 9 A.M. Eastern. Any
batches you submit during this time might be delayed.
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(!) Important Note: For batch jobs with more than 500 K (500 thousand) records, you will need to open a
customer support ticket. For information on contacting Customer Support, see "Resolving Problems" on
page 8-12.

Resolving Installation Issues

These are some of the errors that might occur after you have installed D&B360.

1. After you have completed the installation process, you might receive an error such as the one below:

2. In the D&B Callout logs, you might see errors similar to the following:

l Status Code: -1
l Description: An error occurred. Please try again.
l Exception: System.ServiceModel.CommunicationException: [CrossDomainError]
l Arguments: https://dnbinsight.dnb.com/DaaS/services/RetrieveEntitlementsServiceV30

If any of these errors occur, you need to add the site address of your CRM organization to the Local

Intranet zone in the Internet Options, by doing the following:

1. Go to IE -> Tools -> Internet Options -> Security.

2. Select Trusted Sites -> Site.

3. Add the site address of your CRM organization.
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Resolving Problems

Dun and Bradstreet is committed to a high level of customer satisfaction. An efficient support process is
combined with a communication service level agreement to give our customers quality support.

The communication SLA (Service Level Agreement) is as follows:

Initial Response The maximum timeframe for initial response for all inbound issues is 4
hours.

Ongoing
Communication

SLA Determined with the customer.
Based on mutual agreement of the severity of the issue.
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The communication SLA is based on normal business hours, which are considered to be:

l 8 A.M. – 6 P.M. local time, Monday through Friday

l Excluding D&B holidays

To submit a ticket, go to this URL: http://dnbus.force.com/support?prod=dnb360. You will be prompted to
enter your e-mail address and then fill out a form.
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